
WinADFM
for ADFM/accQmin Flow Systems

Software Instruction Manual

Part #69-7003-025 of Assembly 60-7004-068
Copyright © 2007. All rights reserved, Teledyne Isco, Inc.
Revision B, June 29, 2011

http://www.isco.com




Foreword

This instruction manual is designed to help you gain a thorough understanding of the
operation of the equipment. Teledyne Isco recommends that you read this manual
completely before placing the equipment in service.

Although Teledyne Isco designs reliability into all equipment, there is always the possi-
bility of a malfunction. This manual may help in diagnosing and repairing the malfunc-
tion.

If the problem persists, call or e-mail the Teledyne Isco Technical Service Department
for assistance. Simple difficulties can often be diagnosed over the phone.

If it is necessary to return the equipment to the factory for service, please follow the
shipping instructions provided by the Customer Service Department, including the
use of the Return Authorization Number specified. Be sure to include a note
describing the malfunction. This will aid in the prompt repair and return of the
equipment.

Teledyne Isco welcomes suggestions that would improve the information presented in
this manual or enhance the operation of the equipment itself.

Teledyne Isco is continually improving its products and reserves the right to
change product specifications, replacement parts, schematics, and instruc-
tions without notice. 

Contact Information

Customer Service

Phone: (800) 228-4373 (USA, Canada, Mexico)

(402) 464-0231 (Outside North America)

Fax: (402) 465-3022

Email: IscoCSR@teledyne.com

Technical Support

Phone: (800) 775-2965 (Analytical)

(866) 298-6174 (Samplers and Flow Meters)

Email: IscoService@teledyne.com

Return equipment to: 4700 Superior Street, Lincoln, NE 68504-1398

Other Correspondence

Mail to: P.O. Box 82531, Lincoln, NE 68501-2531

Email: IscoInfo@teledyne.com

Web site: www.isco.com

Revised March 17, 2009

http://www.isco.com
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WinADFM Software

Section 1 Introduction

1.1 Overview WinADFM is designed to provide tools for programming the
ADFM™ and accQmin™ flow meters, field deployment, diag-
nostic testing, data collection, and data review.

1.1.1 System Requirements The following are the minimum suggested computer require-
ments to run WinADFM. WinADFM will run on any system that
supports Windows 95 and higher. However, a faster processor,
more memory, and more available hard drive space will all
combine to make the program run faster and more smoothly.

• IBM compatible PC

• 486 or higher CPU

• 16M RAM

• Windows 95 or higher

• Large hard drive (1 Gb or better)

· Disk Space (or data storage / ZIP Drives) to hold the 
incoming data file.

· Disk Space (or data storage / ZIP Drives) to hold the 
backup files

• Data backup system
WinADFM can be used in-house to create a station configuration
file containing all parameters for setting up, programming, and
starting the ADFM or accQmin. The software can also be used to
program the flow meter in the field.

WinADFM can test the ADFM and accQmin after installation,
initiate meter start-up, and collect and view flow data.

Note
For the ADFM, the "Bench Test" function is for diagnostic pur-
poses and is not required for routine operation. If for any rea-
son the Bench Test is performed, regardless of the time
interval between tests, first retrieve and save all recorded data
before it is performed again. Prior to redeployment, select
"Erase Recorder" and then "Restart."

Note
The accQmin “Bench Test” function requires the connection of
a sensor to the flow meter.
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1.2 Software Installation WinADFM is installed similarly to other Windows compatible
programs. Double-click on the WinADFM Installation file and
follow the instructions on the screen. After installation you can
start WinADFM by clicking on Start > Programs > Teledyne Isco
> WinADFM, or double-click the WinADFM icon on your desktop.

Note
WinADFM versions 1.46 and above support the ADFM Pro-20
and the accQmin flow meters. These versions of WinADFM
use a new station fi le format that is incompatible with
WinADFM versions 1.12 and earlier, and WinADFMPro soft-
ware. If compatibility with WinADFMPro software is
desired, upgrading to this version of software is not rec-
ommended. If you do upgrade to this new version of software
and want to maintain compatibility with WinADFMPro, when
opening an existing station file or when creating a new station
file, do not save the station file in the new format. You can
choose to save the station file in the earlier version format,
which WinADFMPro can open by selecting File, “save station
version” and selecting “Old Version Station File” as the file
type. If you use WinADFMPro to open a station file created
with WinADFM 1.46 with the new format, WinADFMPro will
corrupt the station file and it will not be usable with either
WinADFM 1.46 or WinADFMPro.

WinADFM 1.46 or later must be used with the accQmin. 

1.3 Folders During installation, a WinADFM folder is created with Config
and Data subfolders.

1.3.1 WinADFM Folder This folder contains the executable program and associated files,
as well as the Config folder and the Data folder.

1.3.2 Config Folder The Config subfolder is in the WinADFM folder. Programming
configuration files, called Station files, are created for each flow
meter and its associated flow monitoring site (location). These
Station files are in the Config folder. 

1.3.3 Data Folder The Data folder is in the WinADFM folder, and contains a folder
for each metering site, referred to as the Site ID folders.

1.3.4 Site ID Folder When flow data is downloaded from the flow meter, these files,
called Deployments, are automatically downloaded into a folder
the software creates using the Site ID name of the station file.
This Site ID folder containing downloaded data from the site is
located inside the Data folder. Subsequent downloaded data is
automatically placed in the Site ID folder.

1.4 File Types Operating files are automatically placed in the WinADFM folder.

1.4.1 System Files These files consist of the executable program and its associated
files.



WinADFM Software
Section 1  Introduction

1-3

1.4.2 Station Files These files contain the flow meter programming and application
information for each site. The station file describes a flow moni-
toring site, site-specific application parameters, and the data col-
lection parameters associated with it. The station file is used to
program the flow meter for a specific application, collect and
view flow data from the internal recorder, and run diagnostics.

The default file name for a Station file is the Site ID, followed by
a “.stn” extension. You may change the file name by clicking File
> Save As, and entering a new file name., but the first 8 or fewer
alpha-numeric characters (letters or numbers only) will be used
as the Site ID. If you change the first 8 characters in the file
name from the default site ID name, then you have also changed
the site ID name that will be programmed into the ADFM.

1.4.3 Group Files This type of file contains one or more Station files together under
a single Group name. You may, for example, want to group sites
together that have common operating and polling parameters.
The file name is the Group name followed by the extension “.sgr.”

1.4.4 Log Files A log file is a text document in the Config folder, containing a
record of all communications between the program and the flow
meter for a given site. The file name is the Station file name fol-
lowed by the extension .log. Each successive communication
session is added to the existing log file.

The information in the Log File can be valuable in determining
the cause of a system failure.

1.4.5 Data Files There are three types of data files used with both ADFM and
accQmin meters: Real Time Data files, Quick Data files, and
downloaded Data files. These files, called Deployments, contain
the raw flow data collected from the flow meter. Deployments can
be viewed in WinADFM.

Note
The ADFM recorder must be cleared following data retrieval.
Save all downloaded data and, prior to redeployment, erase
the recorder and restart the ADFM.

The file naming format for accQmin data files (deployments) is
different from that of the ADFM.

ADFM Data Files Data files are written to and stored in the ADFM internal
recorder (if the recorder is turned on). With the exception of
“Listen Real Time”, each time the WinADFM software communi-
cates with the ADFM, the ADFM stops taking flow readings in
order to talk to the computer, and when the communication ends,
the ADFM starts taking readings again. When communication is
established, the ADFM closes the existing data file, and when it
starts taking readings again, a new data file is started in the
recorder. There will be a time gap between the last reading of the
previous deployment and the first reading of the new deployment
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corresponding to the communication time. The internal recorder
can hold up to 1,000 deployments with a combined total file size
of 30 Mb.

When data deployments are downloaded from the ADFM, each
deployment is saved inside the Site ID folder. During this
process, each deployment is automatically named using the date
of the collection and the following naming convention:

#### (ADFM serial number)
M (month 1-9 with a, b, c used for 10, 11, 12)
DD (day)
HH (hour, 24 hour format)
.xxx (deployment number - .001 to .099)

If the hour changes while downloading multiple deployments,
the file name will change accordingly. The files will have dif-
ferent numbered extensions (.001 to .099), corresponding with
the deployment number.

ADFM Real Time Data 
Files

Real time data files update at the sampling rate programmed
into the meter, and contain flow data recorded during on-site
communication with the ADFM. They are viewed live on-site
during ADFM communication, and can also be viewed later
(off-site) with WinADFM. Real Time data is written to the com-
puter communicating with the ADFM during the on-site commu-
nication, and is written to the flow meter if the recorder is
enabled. The Real Time data file is stored on the computer inside
the Data subfolder in the Site ID folder. The naming convention
used is as follows:

rt
YYYY (year)
MM (month)
DD (day)
.xxx (extension)

If Real Time recording is used more than once at the same site in
the same day, each subsequent recording will have the same file
name, with an incrementing extension (.001, .002, .003, etc).

ADFM Quick Data Files The Quick Data feature is used in the field to view real-time
data. Quick Data data files are created when the ADFM is placed
in the Quick Data acquisition mode. Special measurement
parameters are sent to the ADFM that allow flow data updates
approximately every 15-20 seconds. The Quick Data feature is
recommended for field evaluation and diagnostics.

Quick Data creates a data file of the readings and stores it in the
computer. This file will contain data recorded during the time the
real-time display screen is active, and contains the velocity beam
raw data used for diagnostics. This file is automatically named
qd, followed by the year, month, and day with numerical
extension. To view the Quick Data file and for analytical data,
refer to the WinADFM Quick Data Evaluation Section.

If Quick Time recording is used more than once at the same site
in the same day, each subsequent recording will have the same
file name, with an incrementing extension (.001, .002, .003, etc).
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accQmin Data Files Data files (deployments) are written to and stored in the
accQmin (if the recorder is turned on). The recorder holds 2
Megabytes of data and can operate in either Slate or Wrap mode.
In Slate mode, when the recorder is full, the accQmin will con-
tinue to take flow readings, but will not write the flow data to the
recorder. In Wrap mode, when the recorder is full, the oldest flow
data is replaced by the newest.

The recorder holds a single file, which may contain multiple
deployments. Each time data is collected, the entire recorder con-
tents are downloaded. Note: with a full recorder, the col-
lection/download time is approximately 6 minutes. Each time
data is collected from the recorder, it is saved inside the Data
subfolder in the Site ID folder. During this process, each
deployment is automatically named using the date of the col-
lection and the following naming convention: 

xxxxxxxx (site ID/name)
_SNxxx (accQmin serial number)
_YYYY (year of collection)
MM (month of collection)
DD (day of collection)
.000. (extension)

accQmin Real Time Data 
Files

Real Time data files are the same type of file as described above
for the ADFM meter.

The Real Time data file is stored on the computer in the Data
subfolder in the Site ID folder. The recording uses the date: year,
month, hour, minutes, and seconds the recording is started as the
file name with the following naming convention:

rt, YYYY, MM, DD, HH, SS, .001.

accQmin Quick Data Files Quick Data files are the same type of files as described above for
the ADFM meter. For the accQmin, Quick Data mode will update
the data approximately every 45 seconds. The Quick Data file is
stored on the computer inside the Data folder in the Site ID
folder. The recording uses the date - year, month, hour, minutes,
and seconds the recording is started as the file name with the fol-
lowing naming convention:

qd, YYYY, MM, DD, HH, SS .001.
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WinADFM Software

Section 2 ADFM

2.1 Creating a Station File In order to deploy the ADFM, you must first create a station file
for setup and programming.

Click File > New, or click on the blank page toolbar button. The
File New screen will give the options to either create a station
file or group of existing station files. Click on the type of file to be
created – e.g., ADFM Station. Enter the new Site ID in the Site
ID box. The Site ID is limited to 8 alpha-numeric characters
without spaces, or other punctuation or special characters. The
Site ID must be entered before the station file (also known as a
Configuration or Programming file) can be created.

Figure 2-1 New File

After you enter the Site ID and select OK, a Save As dialog will
appear. The Site ID will be the default file name. A longer or dif-
ferent name may be entered,  but  the f irst  8  or  fewer
alpha-numeric characters (letters or numbers only) will be used
as the Site ID. If you change the first 8 characters in the file
name from the default site ID name, then you have also changed
the site ID name that will be programmed into the ADFM.
Ensure that the file will be saved to the Config directory. When
you save the file, a window with default program parameters will
appear.



WinADFM Software
Section 2  ADFM

2-2

Figure 2-2 Station File Window
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2.2 Setup With the station file open, select ADFM in the menu bar and
then select Setup.

This screen is for setting up or editing the ADFM operating
parameters in the station file. The site-specific information in the
station file will be used to program the ADFM. The Setup
window has five tabs where you will enter the information: Site;
Channel; Communication; Profiling; Collection Schedule.

2.2.1 Site tab On the Site tab, enter site-specific information.

Figure 2-3 Site tab

Site ID Site ID is used to name the station file, to create additional chart
configuration files to name, and the station’s data folder. This
entry was made when the station file was created.

Site Name This field contains the commonly used name for the site. This
field can be up to 255 characters long.

Manhole Reference Where applicable, this number identifies the manhole. This field
can be up to 255 characters long.
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Address Where applicable, enter the street address for the site. This field
can be up to 255 characters long. You can use multiple lines by
hitting <Enter>.

Comments Comments concerning the site or the installation may be docu-
mented in this field. This field may be up to 255 characters long.

Units of Measurement Using the dropdown menu, select the units of measure for depth,
velocity, and flow. These units will be used throughout the
program. You can go back to this screen and change the units
after entering pipe/channel dimensions in another screen. The
dimension values are then rescaled to the new units of measure.

2.2.2 Channel tab Use this tab to specify the appropriate channel geometry and
dimensions.

Figure 2-4 Channel tab

Channel Type Select the appropriate channel shape from the column on the left
of the screen. The right side of the screen will display a picture of
the selected channel geometry under Channel Configuration,
along with boxes for entering the channel dimensions.
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Rectangular – Enter the width and height using the units of
measure chosen in the Site Tab.

Circular – Enter the Diameter (pipe inside diameter) using the
units of measure chosen in the Site Tab.

Trapezoidal – Enter the widths and heights (up to three) using
the units of measure chosen in the Site Tab. H2 and H3 must not
be zero (0), and H3 must be greater than H2.

Elliptical – Enter the three characteristic radii and angles of
the ellipse using the units of measure chosen in the Site Tab.
Teledyne Isco recommends using the multi-point channel type
rather than elliptical channel type in most applications, since
pipes or channels with a true elliptical shape are very rare.

Multi-Point – For irregular shapes, select Multi-Point and Con-
figure Channel. The Multi-Point configuration assumes that the
pipe/channel is symmetrical about the vertical center line. For
other configurations, contact Teledyne Isco.

Enter the width 2 (half the width), and the corresponding
height at  that  width,  for  ten di f ferent heights  in the
pipe/channel, beginning with Point 1 as the lowest point. The
bottom is represented by the Origin of 0, 0. As you enter the
width 2 and the height for each point starting with point 1, a
drawing based on the dimensions you enter will appear on the
screen. When all ten points are entered, if the drawing does not
approximate the pipe/channel geometry, adjust the dimensions
you have entered and click Update Display. The drawing will
reflect any changes you make. When finished, click OK to return
to the Channel tab (Figure 2-4).
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Figure 2-5 Multiple Point Configuration for Irregular 
Channels

(Continued from Figure 2-4.)

Bed Level – If there is a layer of permanent silt or debris in the
bottom of the channel or pipe, enter its depth.

Zero Offset – Enter the distance from the bottom of the channel
or pipe to the bottom of the ADFM sensor.

Secondary Depth Sensor – If a secondary depth sensor is not
used, select None. Otherwise, select the Pressure Sensor radio
button or Other if a depth device other than a pressure sensor is
used. Enter the Sensor Span – the full scale range (in psi for a
pressure sensor). Enter the sensor offset. The sensor offset is the
distance from the bottom of the channel or pipe to the top of the
sensor or the sensing element in the sensor.
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2.2.3 Communication Tab This tab is used to enter the appropriate communications pro-
tocol.

Figure 2-6 Communication tab

Select the type of external communications that will be used:
Modem for remote connection, or Serial for direct connection.

Modem Modem is selected only if an internal or external modem is con-
nected to the ADFM and the computer is going to be calling the
ADFM remotely. Enter the phone number of the site in the
Phone # field, including area (or city) codes and any required pre-
fixes. For international dialing, include the local international
prefix and country code. Select the computer’s communication
port to be used, and the maximum speed, from the dropdown
menus. To connect only at the chosen Max Speed, check this box.

Note
Password protection is not yet available with this version of
WinADFM software.
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Serial Serial is selected for direct RS232 connection using the communi-
cation interface cable.

A typical computer will have the following Serial RS-232 commu-
nication settings:

Comm. Port: Select the computer’s active serial/com port.
Default is Com 1. Options are Com 1 – Com 8.

Baud Rate: The selected baud rate is used for data down-
loads only. The default baud rate is 9600.
Options are 1200, 2400, 4800, 9600, 19200,
38400, 57600.

Stop Bits: 1 (Default)

Data Bits: 8 (Default)

Parity: None (Default)

Baud rate applies to serial downloads only. When testing and ini-
tiating startup/programming with WinADFM, the default baud
rate is 9600. However, any computer capable of running
Windows 95 or greater should be able to successfully download
data at a baud rate of 57600. This is recommended to reduce the
download time.

Stop Bits, Data Bits, and Parity should be left at their default
values.
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2.2.4 Profiling Tab The Profiling tab is for setting up flow and data collection mea-
surement parameters.

Figure 2-7 Profiling tab

Select the desired profiling parameters from the list on the left.
Select the desired data types to collect from the list on the right,
as well as data recording and transfer settings.

Data Interval This is the time between successive measurement readings. The
intervals are 1, 2, 5, 10, 15, 20, 30, 60, or 120 minutes.

Minimum Depth This value is one of the factors used to determine the profiling
resolution, i.e., the size of the individual bins in the velocity
profile. Selecting a value higher than the actual minimum expe-
rienced on site may result in a loss of velocity data at this low
flow depth. Enter the expected minimum depth of flow using the
units selected on the Site Tab. Note that the minimum depth for
velocity profiling is approximately 9 inches.



WinADFM Software
Section 2  ADFM

2-10

Max Velocity This value is used to set the velocity measurement range. Enter
the expected maximum velocity. The choices available from the
dropdown menu are 1, 1.5, 3, 5, 7, and 10 m/s or 3, 5, 10, 15, 20,
and 30 ft/s. The program will also accept any legitimate
numerical entry (i.e., using alpha-numeric characters).

It is important to make a solid estimate for this value. Selecting
a higher velocity decreases the precision of the velocity mea-
surement. However, selecting a value too low can lead to velocity
measurement errors. A good rule of thumb is to select a
maximum velocity that is approximately 50% higher than what
you actually expect. After you have collected some data, and have
actual velocity values from the site, you can modify this entry.

Pings The ADFM makes multiple velocity measurements not only at
different points in the water column, but successively in time. An
individual measurement, called a ping, consists of a complete
velocity profile in the water column. However, the precision of the
discharge estimate is improved by averaging many pings
together into an ensemble. An individual ping is very quick; an
ensemble of 400 pings will take no more than about three
minutes.

Under Pings, drag the slide bar left or right to adjust the number
of pings. With the slide bar selected, you can also increment the
number of pings using the left and right arrow keys. When
adjusting pings, the value you choose may be affected by the fol-
lowing two factors:

Velocity precision / % of max velocity – This shows the esti-
mated velocity precision as a percentage of maximum expected
velocity.

Projected Battery Life – This estimates the number of days of
battery power you will have for the selected setup.

Increased precision also means increased energy consumption.
Note that there is a check box for whether the system is battery
powered or not. Also note that the number of pings you can select
is time-dependent. You could not select 1000 pings with a one
minute reading interval because 1000 pings would take a longer
amount of time. But you could select 1000 pings with a 10 or 15
minute interval, giving you a very precise measurement.

Enable Velocity Mode 12 To improve the ping rate, check the box next to Enable Velocity
Mode 12. The increased ping rate provides reduced power con-
sumption while maintaining the same precision.

Improved precision may be obtained by increasing the selected
number of pings. Please contact Teledyne Isco if you are using a
short data interval and wish to program the meter for a greater
number of pings than the program will allow.

Note
Enabling Velocity Mode 12 will not change the displayed val-
ues for Velocity Precision and Projected Battery Life, and will
not change the maximum number of pings allowed for a given
data interval. Velocity Mode 12 will enhance battery life by
approximately 50%.
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Collect Following Data The internal recorder collects flow, velocity, and depth data,
along with additional data that can be used for ADFM perfor-
mance evaluation and diagnostics. The following raw data types
may be recorded and collected by checking their respective
boxes.:

Q, V, D – Discharge values (flow), Average velocity, and depth. Q,
V, D must be checked in all applications to obtain these param-
eters.

Velocity, Amplitude, % Good, Correlation – These data types
are optional. The information collected with these data types is
typically used to analyze the performance of the sensor for diag-
nostic purposes. We recommend that all boxes be checked except
for %Good.

Velocity – Raw beam velocities measured by the ADFM. There
is a velocity value for each bin in each of the four velocity mea-
suring beams. These raw radial Doppler velocities are used to
compute discharge via the system’s discharge algorithm. They
can also be used to generate plots of the velocity distribution
throughout the wetted cross-section. For diagnostic purposes,
this should be checked.

Amplitude – Raw beam intensity amplitudes measured by the
ADFM. There is an amplitude value for each bin in each of the
four velocity measuring beams. Amplitude can be used as a rel-
ative measure of the return echo’s signal strength. For diagnostic
purposes, this should be checked.

% Good – This represents the percentage of pings within an
ensemble that contained valid velocity data. There is a % Good
for each bin in each of the four velocity measuring beams.

The “% Good” option is typically not used.

Correlation – Raw beam correlation values measured by the
ADFM. There is a correlation value for each bin in each of the
four velocity measuring beams.

The correlation value is a useful measure of data quality. In
almost all applications, a correlation value in the region of 128
counts (± 10 counts) signifies valid data. For diagnostic purposes,
this should be checked.

Output – Select Serial.

Record Internally – Check this box to record flow data inter-
nally.

Type of Data Set – To manage the  data  f i le  s ize,  se lect
Reduced.

Note
Quick Data files are always created using the reduced data set
with raw data recorded every reading.

Record Raw Data Every xx Readings – When us ing  the
internal recorder, every flow reading is recorded. Each flow
reading contains the date/time stamp, flow, velocity, and depth if
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the Q,V,D data type box is checked. The recording interval of
additional useful data such as Velocity, Amplitude, and Corre-
lation is determined by the number entered in this step. If this is
set to 1 then the additional data will be recorded with every
reading. If it is set to 2, the additional data will be recorded every
other reading, and so on.

While the inclusion of raw data is useful, it creates a larger file,
which lengthens download time. Teledyne Isco recommends
setting Record Raw Data so that raw data is recorded every 15 to
30 minutes, (e.g. if you set Record Raw Data to 15, for 1 minute
sample intervals, raw data is recorded every 15 readings; for 5
minute sample intervals, raw data is recorded every 3 readings,
etc.) If you are not concerned with file size and/or download time,
or if you are collecting data to aid in troubleshooting data quality
issues, then select 1 for the raw data reading.

2.2.5 Collection Schedule 
Tab

The Collection Schedule is only used for remote communication
via modem or other means. The collection schedule may be
turned on enable automatic scheduled data downloads. To use
this feature, the computer must be on and running WinADFM
software with the station file(s) open. To disable this feature,
select None.

If using a field computer such as a laptop for downloading data
on–site, select None. If Collection Schedule is on and the time for
collection has passed, WinADFM will keep trying to connect to
the ADFM via remote communications, and you will not be able
to direct-connect to the ADFM.

2.2.6 Saving the Program When finished with the programming selections on the setup
tabs, click Apply to save changes but keep the station file open, or
click OK to save and close the file.

2.3 Group Files A group file groups a number of station configuration files
together under a single identity. group files are used to set up a
group of specific stations with common operating and polling
parameters. When you group station files together, the files and
the information they contain are not changed.

To group station files, select File > New. Select Group > OK.
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Figure 2-8 Creating a Group file

Creation of a group file will display the default Group File
window with the default file group name of Untitled.sgr.

2.3.1 Adding Station files To add station files to the new group File, select Edit > Add File.

Select the station file to be added. When all of the station files to
be grouped together have been added, click File > Save As. Name
the file and select Group Files for the file type.

2.3.2 Viewing Grouped Files To view the contents of grouped station files, select File > Open,
and select the file type Group. Select the group of station files to
view (Figure 2-9).
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Figure 2-9 Viewing grouped Station files

The grouped station files appear in the left window. Select the
file you want to view, and the parameters for that station file will
appear in the right window. Scroll on the right to view all of the
parameters in the window.
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2.3.3 Removing Station Files To remove a station file from the group, select Edit > Remove
File.

A separate window will appear, listing the files. Select the station
file and click Remove, then OK.

2.4 Advanced Commands
Advanced commands allow certain operating commands to be
input to the meter. These special commands, entered in the
Dialog window (Figure 2.5.1), are used to change or override one
or more of the default parameters programmed in the meter by
WinADFM software. These commands are only to be used in
special circumstances as determined by Teledyne Isco. Contact
Teledyne Isco before attempting to use the Advanced
Command function.

Figure 2-10 Advanced Commands dialog window
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2.5 Programming and 
Operation

In order to connect to the ADFM, the station file for the metering
site must be open. 

Connect the communication cable between the computer and the
ADFM.

To begin operation of the ADFM click ADFM > Operate.

This will open the Connect Window. All of the ADFM operating
functions for programming, date/time set, testing, operation, and
data collection are available in this window.

Figure 2-11 Connection window



WinADFM Software
Section 2  ADFM

2-17

Select the correct Com Port in the upper left area of the Operate
screen. Click the Connect button to wake up the ADFM and
establish communication. A system status message will appear
in the terminal screen. If the wrong Com Port on the computer is
selected in the Communication Tab of the station file, the error
message “Cannot open port” will appear.

If unable to communicate with the ADFM, the error message "did
not receive prompt." will appear. Check the communication cable
and power to the ADFM. Check to make sure that the correct
Com Port is selected.

The station file (site ID) is unique to an ADFM. If the meter has
not been programmed with the station file that is open, or if the
station file for another ADFM is opened by mistake, a warning
message will appear upon connection:

Figure 2-12 Site ID warning

To connect to the meter and/or program the meter with the open
station file, select Yes. To cancel, select No, then open the appro-
priate station file and Connect.

Note
Clicking No will also restart the meter, to prevent accidental
interruption of data collection.

2.5.1 Dialog Window When a connection is established, an operational status or fault
list will appear in the window (Figure 2-13). The Status list may
indicate "no faults occurred" or it may list one or more "faults"
that have occurred since the last time a connection was made to
the ADFM. Once connection is established, the faults are reset.
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Figure 2-13 Status window

Table 2-1 Possible System Faults

Fault Possible Causes

Power Loss Loss of operating voltage due to low batteries, poor battery contact, power 
supply problem, or batteries were replaced, interrupting power. It may also 
appear after flashing new firmware into the flow meter.

Pressure Sensor Failure The pressure sensor is malfunctioning or the cable connection is bad. It is 
also possible to get this error if the station file was programmed for a sec-
ondary depth sensor and there is no secondary depth sensor connected to 
the ADFM.

Auto Restart Occurred The ADFM was restarted by a microprocessor reset. This is not necessarily 
an error, but just a notice that the ADFM restarted automatically, rather than 
at the user's command. 

Transducer Communications Error The ADFM electronics lost contact with the ADFM sensor. Indicates the 
transducer is not connected, poor sensor connection, or possible trans-
ducer problem.

Recorder Full The ADFM internal recorder has been left on and the recorder is full. Erase 
the internal recorder.

Bus Error Usually indicates a malfunction in the main circuit board. If resetting 
(restarting) the ADFM does not clear the Bus Error or it returns, then it is 
most likely a valid circuit board problem.

Note
If other errors besides those listed above occur repeatedly, contact Teledyne Isco.
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2.5.2 System Information The System Information box provides specific site information:
the Site ID, the voltage powering the ADFM, and the firmware
version, as well as the times and dates from both the computer
and ADFM internal clocks. You can set the ADFM time/date to
the computer’s time by clicking the Set Time button.

The Set Time window will appear. The Timezone Offset sets the
ADFM time to the computer time, plus or minus the offset (in
hours). If the Set ADFM Time To radio button is selected, click in
the date-time field on the date, hour, or minutes to change and
use the up/down arrows to increment to the correct date or time.

2.5.3 Testing the ADFM Diagnostic tests are selectable from the buttons to the right of
the screen. The results of each test are displayed and recorded in
the station’s Log File.

Field Tests The Field Test should be performed in the field with the sensor
installed and underwater. The test performs internal ADFM
system checks. Click Field Test to perform the test.

The first test is labeled PT4, and determines if the transmit path
is operating properly and returns a Pass or Fail for each trans-
ducer beam in the sensor. This test will fail if the transducer is
not connected to the electronics. This test can also fail if there is
a problem in the main circuit board, or the sensor or sensor cable
has a short.

The PT5 test determines if the receive path is operating properly,
and returns a Pass or Fail. Rows 5, 8, and 12 should always be
255 255. The other rows can have 0, 7, or 11, and still be okay
even though the test shows a failure. A failure can be caused by a
noisy environment (external interference). If all rows show 255, a
hardware failure on the main circuit board has occurred.
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Figure 2-14 Second Field Test (PT5)

The PT3 Correlation Magnitude test (Figure 2-15) is an indi-
cation of the quality of the ADFM operation and the environment
in which it is installed. This test can indicate a FAIL even though
the ADFM is working properly. High numbers indicate external
interference or noise. Values for correlation magnitude should
start at 255 for lag 0, and decay steadily as the lag increases.
High Gain RSSI (Relative Signal Strength Indicator) normally
runs between 50 and 90. Values in the 20-30 range indicate an
extremely weak signal, or disconnected sensor. Values higher
than 100 indicates a high-noise environment.

Contact Teledyne Isco for more information and corrective action.

Note
Additional diagnostic tests can be performed using the BBTalk
diagnostic software. Contact Teledyne Isco for additional infor-
mation regarding this software and its use.
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Figure 2-15 3rd Field Test PT3 Correlation Magnitude test)

Bench Test The Bench Test function is for diagnostic purposes and is not
required for routine operation. If for any reason the Bench Test is
performed, regardless of the time interval between tests, first
retrieve and save all recorded data before it is performed again.
Prior to redeployment, select "Erase Recorder" and then
"Restart."

2.6 Program and Restart Select Start Sampling to begin flow monitoring immediately, or
at a predetermined time in the future. Delaying the start of flow
monitoring can be an advantage, if the meter is battery operated.
The system can be set up in-house, programmed using the
Program and Go button, and then transported to the field site at
a later time. Battery power is conserved until the date and time
to start sampling is met.

Check the box next to “Use advanced commands” to activate any
special commands entered in the Advanced Window's dialog box
(see section 2.4).
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Figure 2-16 Start Sampling options

CAUTION
Advanced Commands should only be entered and used as
directed by Teledyne Isco.

2.6.1 Program and Go To load the application and operating parameters configured in
the station file into the ADFM and start the program, click
Program and Go.

After a few seconds of operation, a real-time screen appears, indi-
cating the ADFM has been programmed and started.

To exit the program, click Exit, and the screen will return to the
Operate screen. In the Operate screen, click Exit, then dis-
connect the communication cable. Close the station file and exit
WinADFM.

As long as the real-time screen is active, each time the ADFM
takes a reading based on its programmed sampling interval, the
real-time screen will be updated with the latest flow reading.

In addition to the real-time screen being continually updated, a
data file with the readings is sent to the computer. This file con-
tains data recorded during the time the real-time display screen
is active.

This file is automatically named rt, followed by the two-digit
year, month, and day, with an incrementing extension. The
extensions begin at .001. If Program and Go mode is used more
than once in the same day, the second rt data file will have the
extension .002, the third, .003, and so on. Data collected in Real
Time mode will also be stored in the ADFM's internal recorder if
the internal recorder is enabled.

The real-time display shows flow information in tabular format
including Depth, Ultrasonic Depth, Secondary Depth, Qmain
(actual computed flow), Qmann (computed Manning flow – if
available), QmodAV computed flow, Average Velocity, and Raw
Velocity. A hydrograph and the raw data velocity signal graphs
are also shown (Figure 2-17).

Click Exit to return to the Connect screen.
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Figure 2-17 Program and go real-time data screen

Graphs The top graph builds a hydrograph as real-time data is received. 

Velocity Beam Graphs The four graphs below the hydrograph show the raw velocity
beam data. This data is used to assess the quality of sensor
installation, the hydraulics at the sensor location, and the oper-
ation of the ADFM system. Velocity beam data is shown as beam
radial velocity for each beam and bin. X, Y, Z, and E vectors at
each bin location indicate correlation (a measure of signal
quality), and amplitude (a measure of signal strength). Beam
velocities should be symmetrical about the Y axis. X, Z, and E
vectors should be near zero, and the Y vector should approximate
the horizontal velocity in the pipe or channel. Ideal correlation
values are around 128. Amplitude (for bins below the water
surface) should be at least 30-40 counts above the High Gain
RSSI values shown in the PT3 portion of the Field Test. For more
information on interpreting velocity beam graphs, please contact
Teledyne Isco. For specific information on the velocity beam
graphs, refer to Section 2.8.3 Expert View.

Depth Main depth used in flow calculation. Depth information from the
primary ultrasonic depth sensor is compared to depth infor-
mation from secondary depth sensor (if used). Best fit is deter-
mined and used for final (Ultrasonic) depth.

Ultrasonic Depth This is the depth measured by the primary (ultrasonic) depth
sensor.

Secondary Depth Secondary depth readings appear here, if a secondary depth
sensor is being used.
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Qmain Qmain is the final output of flow rate value after determination
of the value by internal algorithms within the ADFM. Other flow
rates shown in the plot, e.g., Qshape and QmodAV, are diagnostic
in nature and should not be used except under the advice of
Teledyne Isco. An exception is Qmann – the flow rate calculated
by a Manning equation based formula, calibrated using histori-
cally measured data. When the flow depth drops below the
ADFM's minimum capability for measuring velocity, the Qmann
value is used for Qmain.

Average Velocity Velocity divided by cross-sectional area.

Raw Velocity Average of individual point velocities from the four velocity
beams

Note
The same display appears for the three modes: Program and
Go, Quick Data, and Listen Real-Time. However, each mode
performs a different function. See Section 2.6.5 for an explana-
tion of these differences.

2.6.2 Adjust Offsets The Adjust Offsets feature is used in the field to check or adjust
the depth calibration of the ultrasonic depth transducer and/or
the secondary depth sensor.

Figure 2-18 Adjust Offsets window

When the screen opens, it will automatically update the ultra-
sonic and secondary depth readings. Enter the manually mea-
sured Depth. Click Calculate, and the new sensor offset will be
calculated. Click Set to change the existing sensor offset to the
new offset and program it into the ADFM. The new offset is also
saved in the station file.
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Note
When clicking the Set button, watch the window box below the
Set button. If the window is not able to reprogram the new off-
set into the ADFM because the ADFM is doing other calcula-
tions, the window will indicate a failure. Clicking on the Set
button a second time usually reprograms the ADFM, and it will
be indicated in the window. When finished, click Exit.

2.6.3 Quick Data Mode The Quick Data feature is recommended for field evaluation and
diagnostics.

Quick Data is used in the field to view real-time data. Quick
Data displays a graphical and tabular screen in real time with a
data update approximately every 15-20 seconds. The Quick Data
real-time display is identical to the Program and Go display,
except for the update time.

Note
If the ADFM Velocity Mode 12 is enabled, the Quick Data
update may take up to 60 seconds.

Note
Upon exiting this screen, restart the meter using either the Pro-
gram & Go or Restart button.

Quick Data creates a data file of the readings and stores it in the
computer. This file will contain data recorded during the time the
real-time display screen is active, and contains the velocity beam
raw data used for diagnostics. This file is automatically named
qd, followed by the year, month, and day with numerical
extension. To view the Quick Data file and for analytical data,
refer to the WinADFM Quick Data Evaluation Section.

Note
The same display appears for the three modes: Program and
Go, Quick Data, and Listen Real-Time. However, each mode
performs a different function. See Section 2.6.5 for an explana-
tion of these differences.

2.6.4 Listen Real-time Mode Listen Real-time can be used in the field to view real-time data.
The Listen Real-time display is the same as the Program and Go
real-time display and Quick Data display. The Listen Real-time
information is updated on the screen each time the meter takes a
reading. In other words, it updates at the programmed sample
interval.

During the Listen Real Time mode, the internal recorder, if acti-
vated, continues to store data. Upon exiting this mode, the
current deployment continues and a new deployment is not
started in the recorder.
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Note
The same display appears for the three modes: Program and
Go, Quick Data, and Listen Real-Time. However, each mode
performs a different function. See Section 2.6.5 for an explana-
tion of these differences.

2.6.5 Defining the Three 
Modes

Although the three modes display the same graphical, tabular
screen, their functions differ.

Program and Go This function programs or reprograms the ADFM based on the
configuration settings in the station file. Starts a new
deployment and captures data on the computer, and also stores
the data on the meter's internal recorder if the recorder is
enabled.

Listen Real-time Listen Real-time captures data on the computer as sent out by
the meter. If the internal recorder is on, data continues to be
recorded to the current deployment. Upon exiting this mode, the
current deployment continues, rather than a new one starting.

Quick Data Quick Data is used in the field to view real-time data. This mode
updates the display screen approximately every 15-20 seconds,
and is used in the field to view the operation of the ADFM on-site
and verify proper operation of the system. A specially modified
configuration is used to obtain more rapid updates than would
normally be available, including a reduced number of pings.

2.6.6 Restart This button will restart the ADFM using the programmed
parameters currently stored in its memory.

2.6.7 Sleep Sends an "off" command to the ADFM that puts it in Sleep mode.
The ADFM will not wake up at the specified sample time and
take a reading. In Sleep mode, the ADFM will only wake up and
start operating when a wakeup command is sent via the Connect
button.

Note
If the ADFM is put to sleep, immediately disconnect the serial
connection to the computer to prevent and accidental wake-up
of the ADFM.
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2.7 Downloading and 
Viewing Data

To download data from the recorder, open the Connect window
(see section 2.5). Connect to the ADFM and click Collect Data.
The Collect Data window appears and shows the amounts of
available and used recorder space to the nearest megabyte. The
Available Deployments indicates the number of data files cur-
rently in the recorder. The Last Download indicates the number
of the last deployment downloaded.

Note
The ADFM recorder must be cleared following data retrieval.
Save all downloaded data and, prior to redeployment, erase
the recorder and restart the ADFM.

Figure 2-19 Collect Data window

Note
The Last Download information is stored in the station file, not
the ADFM. Therefore, if a different computer is used to down-
load recorder deployments each time, the Last Download infor-
mation may be incorrect.

Select the desired Collect mode from the three options and click
Download.

The Transferring Data Bar appears. This window shows the
name of the file as well as the size of the file and the number of
bytes collected in real time. When the file(s) have been trans-
ferred, the message “Transfer completed successfully” will
appear. Exit to return to the Operate screen.



WinADFM Software
Section 2  ADFM

2-28

Note
If the recorder is completely full, data collection could take sev-
eral hours. See instructions to erase the data, at the bottom of
this page.

Figure 2-20 Data transfer indicator

When the download is finished, erase the recorder by clicking
Erase Data.

When finished, restart the ADFM by doing one of the following:

• Click Restart to keep current program settings,
or

• Click Program & Go to save new program settings. 
When the Program & Go screen appears, click Exit.

Disconnect the communication interface cable from the ADFM,
exit the Operate screen, and quit the WinADFM software
program.
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2.8 Viewing Data Data collected from the ADFM during Quick Data or Real Time
mode, or data collected from the internal recorder, may be viewed
using the View Data menus.

Open the station file of the site you want to view data from. From
the Menu bar, select Display > Data.

The Data file selection screen will appear. This screen lists all of
the Quick Data (qt), Real Time (rt), and internal recorder deploy-
ments available for the selected site.

Figure 2-21 ADFM Data window

The ADFM Data window provides several options for viewing the
data. Highlight the data file you want to view and then click the
viewing option on the right side of the window.



WinADFM Software
Section 2  ADFM

2-30

2.8.1 Hydrograph The hydrograph displays time series data, showing flow, velocity,
depth, and fluid temperature.

Figure 2-22 Hydrograph

A vertical dotted line on the graph represents a specific
Ensemble (Data Point). The specific ensemble information,
including the values, is shown in the table to the right of the
graph. Click a point in the graph to move the dotted line and
display the values for that specific ensemble.

The slide bar below the table allows you to move from one
ensemble to another. The boxes beneath the slide bar show the
ensemble number. The arrows are used for moving to the
beginning or end of the graph, or to move to the next or previous
ensemble.

The Data Range box shows the starting and ending date/time of
the first and last ensemble. The start/end date/time of the graph
can be changed by clicking the arrows, or by typing the value in
the box.
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To change the graph range, colors, and line thickness, right-click
on the graph. A submenu will appear. Select Properties from the
submenu.

A Playback feature is activated by clicking the Play button. This
will advance the dotted line one ensemble at a time. To speed up
or slow down the playback, change the msec/Ensemble time
value in the box to the right of the Play button.

2.8.2 Scatter Plot The scatter plot window has check boxes to view Velocity vs.
Depth, Flow vs. Depth, and HC (Hydraulic Coefficient) vs. Depth.
Radio Buttons are provided to select either Variable N or Fixed N
for HC calculations.

Figure 2-23 Scatter Plot

Hydraulic Coefficient is back-calculated from Q, depth, and
channel geometry, based on the Fixed or Variable N radio button.

Variable N assumes that the coefficient of friction used in the
Manning equation varies with depth of flow. Fixed N assumes
that the coefficient of friction used in the Manning equation is
constant and independent of depth of flow.
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2.8.3 Expert View Expert View includes graphical displays of the hydrograph and
raw data.

Figure 2-24 Expert View: XYZ Vectors

Expert View also shows tabular values for Depth, Ultrasonic
Depth, Secondary Depth, Qmain, Qmann, QmodAV, Average
Velocity, Raw Velocity, and BIT (Built-In Test) values.

Graphs The top graph is a hydrograph of Q, V, and D.

Velocity Beam Graphs The three graphs below the hydrograph show raw data infor-
mation.

Depth Main depth used in flow calculation. Depth information from the
primary ultrasonic depth sensor is compared to depth infor-
mation from secondary depth sensor (if used). Best fit is deter-
mined and used for main depth.

Average Velocity Velocity divided by cross-sectional area.

Raw Velocity Average of individual point velocities from the four velocity
beams.

Qmain Flow determined by one of four different flow calculations. The
ADFM calculates four different flow values - Qpro, ModAV, AV,
and (optionally) the Manning equation.

Qpro Diagnostic value used by Teledyne Isco, which should be ignored
by the user. Qmain is the only flow value that is used for data
output.
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QmodAV Diagnostic value used by Teledyne Isco, which should be ignored
by the user. Qmain is the only flow value that is used for data
output.

Qav Diagnostic value used by Teledyne Isco, which should be ignored
by the user. Qmain is the only flow value that is used for data
output.

Qmann Seven to nine inches of depth is required for velocity profiling.
Below that depth, flow is calculated using a calibrated Manning
equation. The calibration is based on historical velocity readings,
stored and updated during velocity profiling. Velocity is not dis-
played when Manning-based flow value is calculated.

XYZ Vectors XYZ vectors refer to velocity components resolved into an XYZ
coordinate system. They are resolved by transforming the mea-
sured raw velocity vectors – the beam velocities (see next section)
– into a normal three-dimensional coordinate system. In the
ADFM's frame of reference, a positive Y velocity vector repre-
sents downstream flow. Looking downstream, an X velocity
vector is a component of flow velocity to the right, and a Z
velocity vector is a component of flow velocity traveling upward.
The graph in Figure 2-24 shows the profiles of these three
velocity components. The E component is the error of the XYZ
component resolution.

Bit Codes BIT (Built in Test) codes indicate errors that occurred during the
course of an individual reading. Beginning with WinADFM
version 1.47, BIT codes are displayed in hexidecimal form. See
Appendix A BIT Codes for ADFM and accQmin for details.
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Beam Velocities Under Beam Graph, if you select Beam Velocities, the velocity
Beam Graph replaces the XYZ Vector Graph. The velocity beam
data can be used to interpret the quality of the ADFM operation
and data.

Figure 2-25 Expert View: Beam Velocities

Beam Velocity profiles (shown to the left) refer to the raw
Doppler-based velocity components measured by each individual
beam. The Doppler effect is a directional phenomenon. The
Doppler shift detected by any of the acoustic beams will be a
direct representation of the velocity component along the
acoustic beam’s transmit and receive path. Therefore, each beam
will produce its own raw velocity measurements, producing a
profile of velocity components along the acoustic beam. These are
the raw measurements that are transformed into the YXZ coor-
dinate system to produce the Vector profiles shown in the XYZ
graph.

Interpreting beam and 
XYZ plots

Both the Beam Velocity and XYZ Vector plots give information
about the quality of the ADFM sensor installation and
alignment. In a perfect installation, Beams 1 & 3 will be equal in
amplitude and opposite in sign. Beams 2 & 4 will also be equal in
amplitude and opposite in sign, but will have a greater
amplitude than 1 & 3 by approximately 50%. This is due to the
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different angles of the different beams. By observing departures
from the expected ideal, the user can determine if the sensor is
misaligned, and the nature of the misalignment.

Of course, asymmetrical beam profiles can be caused by
hydraulic conditions, even in the case of a perfect installation. To
determine the true cause of any asymmetry, the user can
examine other data quality parameters that the ADFM measures
and collects with each flow rate measurement.

2.8.4 Data Quality 
Parameters

Correlation

Correlation is a measure of the quality of the processed velocity
information. An expected Correlation value is approximately 128
counts. A count is an arbitrary unit unique to the ADFM. Lower
Correlation values (e.g., below 100) are an indication of poor
quality velocity data. Higher Correlation values (e.g., above 150)
can be an indication of external interference (noise) or the
presence of a "hard" acoustic barrier (e.g., the surface). If the Cor-
relation is at a high level for part or all of the profile, this is an
indication of noise. If the Correlation displays a hard spike, as it
does in the example to the left, this is an indication of a hard
barrier; in this case, the surface.

Note in this example that all four acoustic beams display the
spike at approximately the same place. With better resolution on
the graph, we would see that the spikes for Beams 1 and 3 hit the
surface simultaneously, as do Beams 2 and 4. This symmetry
indicates that the sensor is properly aligned with the pipe or
channel. Therefore, any departure in the symmetry of the
velocity measurements would be an indicator of less than ideal
hydraulic conditions. If the spikes were not coincident, this
would be an indication of sensor misalignment.

Amplitude

An ADFM operates by emitting a sound pulse and then receiving
the echoes backscattered by material suspended in the flow.
Amplitude data is a measure of the signal strength of these
echoes. The amplitude normally decays from a high value near
the sensor (bottom of graph) to a lower value at the end of the
profile range (near the top of the graph). This is due to several
factors, including the natural spread of sound energy as it travels
farther away and loss due to absorption of sound energy by the
water and suspended material. Large spikes should also be
expected in the amplitude profile where the beams contact the
surface.
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2.8.5 Examples of Raw Data The following examples provide a guide for interpreting the data
in Expert View.

Figure 2-26 Excellent raw data – excellent sensor alignment 

Figure 2-27 Typical raw data waveforms
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Figure 2-28 Poor amplitude – debris influence

In Figure 2-28, debris is starting to cover Beam 1 (front right
transducer).

Figure 2-29 Poor amplitude – debris blocking signal

In Figure 2-29, Beams 1 and 2 (front) are both covered by debris.



WinADFM Software
Section 2  ADFM

2-38

Figure 2-30 Bad data – No signal amplitude and low correlation.

Figure 2-31 Noise – External interference (EMI/RFI)

Noise interference (Figure 2-31) is indicated by high correlation
values – much higher than the expected 128 counts.

2.8.6 Flow Profile The flow profile window shows both a hydrograph and a color
contour plot of the flow profile. This flow profile is developed from
the raw beam velocity profiling information. This raw velocity
data is entered into an algorithm that produces a mathematical
description of velocity as a function of position within the pipe or
channel. The Y axis represents channel height, and the X axis
represents channel width. Velocity is represented by different
colors.

To view the flow profile, select the data file from the ADFM Data
window (Figure 2-21) and click “Flow Profile”.
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Figure 2-32 Flow Profile window

Resolution High resolution has better resolution, but takes longer to
compute.

Velocity Scale Scale automatically or set minimum and maximum velocities to
use in the profiling range. All other features are similar to those
described in Hydrograph, above.
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2.8.7 Table To view the data in tabular form, select the desired data file from
the list.

A data file can be saved in CSV or extended CSV format for use
in a spreadsheet. To save in CSV, highlight the data file, checking
the box for extended CSV if desired, and click Save as CSV.

Figure 2-33 Tabular data display

A data file saved in CSV format and then opened with a spread-
sheet program will show Date/Time, Depth, Velocity, and Flow.
The same data saved as extended CSV provides more data infor-
mation and is shown in Figure 2-34).

Note
Only Qmain is ever output as the final flow value as computed
by the ADFM. All other Q-related values are for diagnostic pur-
poses, and should be ignored by the user.
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Figure 2-34 Tabular data in Extended CSV format
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2.8.8 Composite View Composite view provides a composite hydrograph of multiple
data files. To select more than one file to view, highlight the first
file, hold down the Control key, and highlight the other file(s) to
view.

Figure 2-35 Composite view

2.8.9 Reprocessing Data The reprocessing screen (Figure 2-36) is used to reprocess
selected deployments. Reprocessing may become necessary, for
example, if the channel dimensions were specified incorrectly in
the station configuration file, or to remove data acquired with
beams affected by debris.
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Figure 2-36 Reprocessing data

To load the current channel dimensions, click Load Current
Station. To change the dimension, edit the current channel
dimension(s) to the desired dimension(s). If the deployment to be
adjusted does not appear in the Input File field, click Browse and
select the deployment. Click Fix. If the Output File is set to Gen-
erate Automatically, the original file name will be used, followed
by “fix”. The file will be located in the same data folder as the
original file.

To add or change the Bed Level or Zero Offset, use the same pro-
cedure as above.

To remove one of the velocity beams from the data, select the
Primary Beam to be removed. If two beams are to be removed,
select the Secondary Beam. Click Fix, and the data will be repro-
cessed with the selected beam(s) removed.

Note
The remaining features, Advanced and Vectors, are not avail-
able in this version of WinADFM software (1.46).
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3-1

WinADFM Software

Section 3 accQmin (Shallow Water Meter)

3.1 Creating a Station File In order to deploy the accQmin, you must first create a station
file for setup and programming.

Click File > New, or click the blank page toolbar button. The File
New screen will give the options to either create a station file or
group of existing station files. Click the type of file to be created –
e.g., AccQmin Station. Enter the new Site ID in the Site ID box.
The Site ID is limited to 8 alpha-numeric characters without
spaces, or other punctuation or special characters. The Site ID
must be entered before the station file (also known as a Configu-
ration or Programming file) can be created.

Figure 3-1 New File

After you enter the Site ID and select OK, a Save As dialog will
appear. The Site ID will be the default file name. A longer or dif-
ferent name may be entered,  but  the f irst  8  or  fewer
alpha-numeric characters (letters or numbers only) will be used
as the Site ID. If you change the first 8 characters in the file
name from the default site ID name, then you have also changed
the site ID name that will be programmed into the accQmin.
Ensure that the file will be saved to the Config directory. When
you save the file, a window with default program parameters will
appear.
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Figure 3-2 Station File Window
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3.2 Setup With the station file open, select ADFM in the menu bar and
then select Setup.

This screen is for setting up or editing the accQmin operating
parameters in the station file. The site-specific information in the
station file will be used to program the accQmin. The Setup
window has four tabs where you will enter the information: Site;
Channel; Communication; Profiling.

3.2.1 Site tab On the Site tab, enter site-specific information.

Figure 3-3 Site tab

Site ID Site ID is used to name the station file, to create additional chart
configuration files to name, and the station’s data folder. This
entry was made when the station file was created.

Site Name This field contains the commonly used name for the site. This
field can be up to 255 characters long.

Manhole Reference Where applicable, this number identifies the manhole. This field
can be up to 255 characters long.
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Address Where applicable, enter the street address for the site. This field
can be up to 255 characters long. You can use multiple lines by
hitting <Enter>.

Comments Comments concerning the site or the installation may be docu-
mented in this field. This field may be up to 255 characters long.

Units of Measurement Using the dropdown menu, select the units of measure for depth,
velocity, and flow. These units will be used throughout the
program. You can go back to this screen and change the units
after entering pipe/channel dimensions in another screen. The
dimension values are then rescaled to the new units of measure.

3.2.2 Channel tab Use this tab to specify the appropriate channel geometry and
dimensions.

Figure 3-4 Channel tab

Channel Type Select the appropriate channel shape from the column on the left
of the screen. The right side of the screen will display a picture of
the selected channel geometry under Channel Configuration,
along with boxes for entering the channel dimensions.
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Rectangular – Enter the width and height using the units of
measure chosen in the Site Tab.

Circular – Enter the Diameter (pipe inside diameter) using the
units of measure chosen in the Site Tab.

Trapezoidal – Enter the widths and heights (up to three) using
the units of measure chosen in the Site Tab. H2 and H3 must not
be zero (0), and H3 must be greater than H2.

Elliptical – Enter the three characteristic radii and angles of
the ellipse using the units of measure chosen in the Site Tab.
Teledyne Isco recommends using the multi-point channel type
rather than elliptical channel type in most applications, since
pipes or channels with a true elliptical shape are very rare.

Irregular – For irregular shapes, select Irregular and Configure
Channel. The Irregular configuration assumes that the
pipe/channel is symmetrical about the vertical center line. For
other configurations, contact Teledyne Isco.

Enter the width 2 (half the width), and the corresponding
height at  that  width,  for  ten di f ferent heights  in the
pipe/channel, beginning with Point 1 as the lowest point. The
bottom is represented by the Origin of 0, 0. As you enter the
width 2 and the height for each point starting with point 1, a
drawing based on the dimensions you enter will appear on the
screen. When all ten points are entered, if the drawing does not
approximate the pipe/channel geometry, adjust the dimensions
you have entered and click Update Display. The drawing will
reflect any changes you make. When finished, click OK to return
to the Channel tab (Figure 3-4).
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Figure 3-5 Multiple Point Configuration for Irregular 
Channels

(Continued from Figure 3-4.)

Bed Level – If there is a layer of permanent silt or debris in the
bottom of the channel or pipe, enter its depth.

FCP – Enter the height of the Flow Conditioning Platform if
used.

Zero Offset – Enter the distance from the bottom of the channel
or pipe to the bottom of the sensor.

Secondary Depth Sensor – If a secondary depth sensor is not
used, select None from the dropdown menu. Otherwise, select
Pressure Sensor or Other if a depth device other than a pressure
sensor is used. Enter the Sensor Span – the full scale range (in
psi for a pressure sensor). Enter the sensor offset. The sensor
offset is the distance from the bottom of the channel or pipe to
the top of the sensor or the sensing element in the sensor.
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3.2.3 Communication Tab This tab is used to enter the appropriate communications pro-
tocol.

Figure 3-6 Communication tab

Select the type of external communications that will be used:
Modem for remote connection, or Serial for direct connection.

Modem Modem is selected only if an external modem is connected to the
accQmin and the computer is going to be calling the accQmin
remotely. Enter the phone number of the site in the Phone # field,
including area (or city) codes and any required prefixes. For
international dialing, include the local international prefix and
country code. Select the computer’s communication port to be
used, and the maximum speed, from the dropdown menus. To
connect only at the chosen Max Speed, check this box.

Note
Password protection is not yet available with this version of
WinADFM software.
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Serial Serial is selected for direct RS232 connection using the communi-
cation interface cable.

A typical computer will have the following Serial RS-232 commu-
nication settings:

Comm. Port: Select the computer’s active serial/com port.
Default is Com 1. Options are Com 1 – Com 8.

Baud Rate: The selected baud rate is used for data down-
loads only. The default baud rate is 9600.
Options are 1200, 2400, 4800, 9600, 19200,
38400, 57600.

Stop Bits: 1 (Default)

Data Bits: 8 (Default)

Parity: None (Default)

Baud rate applies to serial downloads only. When testing and ini-
tiating startup/programming with WinADFM, the default baud
rate is 9600. However, any computer capable of running
Windows 95 or greater should be able to successfully download
data at a baud rate of 57600. This is recommended to reduce the
download time.

Stop Bits, Data Bits, and Parity should be left at their default
values.
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3.2.4 Profiling Tab The Profiling tab is for setting up flow and data collection mea-
surement parameters.

Figure 3-7 Profiling tab

Select the desired profiling parameters listed on the left of the
screen. From the right side, select the desired data types to
collect, as well as data recording and transfer settings.

Data Interval This is the time between successive measurement readings. The
intervals are 1, 2, 5, 10, 15, 20, 30, 60, or 120 minutes.

Samples per Interval The accQmin makes multiple velocity measurements not only at
different points in the water column, but successively in time. An
individual measurement (sample) consists of a complete velocity
profile. However, the precision of the discharge estimate is
improved by averaging several measurements together. An indi-
vidual sample takes approximately one minute.

Two factors can help determine the number of samples to select:
Velocity precision and Projected Battery Life.

Velocity precision – This shows the estimated velocity pre-
cision as a percentage of maximum expected velocity.
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Projected Battery Life – This estimates the number of days of
battery power you will have for the selected setup.

Note that there is a check box for whether the system is battery
powered or not. Note also that longer Data Intervals allow for
more Samples per Interval, increasing the velocity precision (%
of maximum velocity decreases). Increased precision, however,
also means increased energy consumption, shortening battery
life.

For externally powered systems, select the Samples per Interval
value that results in the desired measurement precision, up to
the maximum value allowed based on the selected Data Interval.
Values above 5 are not normally required or desired.

Enable Burst Sampling 
(Secondary Measurement 
Interval)

You may want to increase the measurement interval during
higher flow conditions. To program this secondary interval, check
the Enable Burst Sampling box and click Configure. Select the
Data Interval and Number of Samples from the dropdown
menus. Enter the Enter Level (value that triggers Burst Sam-
pling) and Exit Level (value that deactivates Burst Sampling and
returns the accQmin to the normal measurement interval).

Figure 3-8 Settings for Burst Sampling

You may use any or all of the parameters Q (flow), V (velocity),
and D (depth). For the parameter(s) you do not want to trigger
Burst Sampling, enter values higher than the expected
maximum.

Included Data Types The internal recorder collects flow, velocity, and depth data,
along with additional data that can be used for accQmin perfor-
mance evaluation and diagnostics. The following raw data types
may be recorded and collected by checking their respective
boxes.:
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Q, V, D – Discharge values (flow), average velocity, and depth. Q,
V, D must be checked in all applications to obtain these param-
eters.

Raw Grid Data, Amplitude, Profile Data, and Config are
optional. This information is typically used to analyze the perfor-
mance of the sensor (velocity beams) in the flow stream for diag-
nostic purposes. However, Teledyne Isco recommends selecting
all data types.

Output – Select Serial.

Record Internally – Check this box to record flow data inter-
nally. Select between Wrap and Slate data recording modes. In
Wrap mode, as the recorder fills up, the oldest data is over-
written by the newest data. In Slate mode, when the recorder
fills up the accQmin will continue taking and outputting
readings at the specified data interval, but the new readings will
not be stored.

Type of Data Set – To manage the  data  f i le  s ize,  se lect
Reduced.

Note
accQmin Quick Data files are always created using the stan-
dard accQmin data set.

Record Raw Data Every xx Readings – When the internal
recorder is used, every flow reading is recorded. Each flow
reading contains the date/time stamp, flow, velocity, and depth if
the Q,V,D data type box is checked. The recording interval of
additional useful data such as Velocity, Amplitude, and Corre-
lation is determined by the number entered in this step. If this is
set to 1, the additional data will be recorded with every reading.
If it is set to 2, the additional data will be recorded every other
reading, and so on.

While the inclusion of raw data is useful, it creates a larger file,
which lengthens download time and fills the recorder memory
faster. Teledyne Isco recommends setting Record Raw Data so
that raw data is recorded every 15 to 30 minutes, (e.g. if you set
Record Raw Data to 15, for 1 minute sample intervals, raw data
is recorded every 15 readings; for 5 minute sample intervals, raw
data is recorded every 3 readings, etc.) If you are not concerned
with file size and/or download time, or if you are collecting data
to aid in troubleshooting data quality issues, then select 1 for the
raw data reading.

3.2.5 Saving the Program When finished with the programming selections on the setup
tabs, click Apply to save changes but keep the station file open, or
click OK to save and close the file.



WinADFM Software
Section 3  accQmin (Shallow Water Meter)

3-12

3.3 Group Files A group file groups a number of station configuration files
together under a single identity. group files are used to set up a
group of specific stations with common operating and polling
parameters. When you group station files together, the files and
the information they contain are not changed.

To group station files, select File > New. Select Group > OK.

Figure 3-9 Creating a Group file

Creation of a group file will display the default Group File
window with the default file group name of Untitled.sgr.

3.3.1 Adding Station files to 
a Group

To add station files to the new group File, select Edit > Add File.

Select the station file to be added. When all of the station files to
be grouped together have been added, click File > Save As. Name
the file and select Group Files for the file type. 

3.3.2 Viewing Grouped Files To view the contents of grouped station files, select File > Open,
and select the file type Group. Select the group of station files to
view (Figure 3-10). The grouped station files appear in the left
window. Select the file you want to view, and the parameters for
that station file will appear in the right window. Scroll on the
right to view all of the parameters in the window.
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Figure 3-10 Viewing grouped Station files

3.3.3 Removing Station Files To remove a station file from the group, select Edit > Remove
File.

A separate window will appear, listing the files. Select the station
file and click Remove, then OK.
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3.4 Advanced Commands Advanced commands allow certain operating commands to be
input to the meter.

These special commands, entered in the Dialog window (Figure
3.5.1), are used to change or override one or more of the default
parameters programmed in the meter by WinADFM software.
These commands are only to be used in special circumstances as
determined by Teledyne Isco. Contact Teledyne Isco before
attempting to use the Advanced Command function.

Figure 3-11 Advanced Commands dialog window

3.5 Programming and 
Operation

In order to connect to the accQmin, the station file for the
metering site must be open.

Connect the communication cable between the computer and the
accQmin.

To begin operation of the accQmin, click ADFM > Operate.

This will open the Connect Window. All of the accQmin operating
functions for programming, date/time set, testing, operation, and
data collection are available in this window.
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Figure 3-12 Connection window

Select the correct Com Port in the upper left area of the Operate
screen. Click the Connect button to wake up the accQmin and
establish communication. A system status message will appear
in the terminal screen. If the wrong Com Port on the computer is
selected in the Communication Tab of the station file, the error
message “Cannot open port” will appear.

If unable to communicate with the accQmin, the error message
"did not receive prompt." will appear. Check the communication
cable and power to the accQmin. Check to make sure that the
correct Com Port is selected.

The station file (site ID) is unique to a meter. If the meter has not
been programmed with the station file that is open, or if the
station file for another accQmin is opened by mistake, a warning
message will appear upon connection:

Figure 3-13 Site ID warning
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To connect to the accQmin and/or program it with the open
station file, select Yes. To cancel, select No, then open the appro-
priate station file and Connect.

Note
Clicking No will also restart the meter, to prevent accidental
interruption of data collection.

3.5.1 Dialog Window When a connection is established, a status message will appear
in the window (Figure 3-14). The accQmin status message will
not include any fault indications, even if fault conditions exist.

Figure 3-14 Status window

3.5.2 System Information The System Information box provides specific site information:
the Site ID, the voltage powering the accQmin, and the firmware
version, as well as the times and dates from both the computer
and accQmin internal clocks. You can set the accQmin time/date
to the computer’s time by clicking the Set Time button.
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The Set Time window will appear. The Timezone Offset sets the
accQmin time to the computer time, plus or minus the offset (in
hours). If the Set accQmin Time To radio button is selected, click
in the date-time field on the date, hour, or minutes to change and
use the up/down arrows to increment to the correct date or time.

3.5.3 Testing the accQmin Diagnostic tests are selectable from the buttons to the right of
the screen. The results of each test are displayed and recorded in
the station’s Log File.

Bench Test The Bench Test can be performed either in-house or on-site, but
requires that the sensor be connected to the accQmin before
starting the test. This test performs a series of system tests to
determine if all the required accQmin systems are present and
functioning. Click Bench Test to start the test.

Figure 3-15 Bench Test screen
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Field Test The Field Test should be performed in the field with the sensor
installed and underwater. Click Field Test to perform the test.

The PT3 Correlation Magnitude test (Figure 2-2) is an indication
of the quality of the accQmin operation and the environment it is
installed in. Test results are provided for four cases (High
Gain/Wide Bandwidth, Low Gain/Wide Bandwidth, High
Gain/Narrow Bandwidth, and Low Gain/Narrow Bandwidth).
Normally, only the High Gain/Narrow Bandwidth results are
important. Values for correlation magnitude should start at 100
for lag 0 and decay steadily as the lag increases. Higher values at
lag 7 indicate more external interference or noise. High Gain
RSSI (Relative Signal Strength Indicator) values will normally
be between 60 and 70. Values greater than 80 indicates a
high-noise environment.

Contact Teledyne Isco for more information and corrective action.

Additional diagnostic tests can be performed using the BBTalk
diagnostic software. Contact Teledyne Isco for additional infor-
mation regarding this software and its use.

Figure 3-16 Field Test (PT3 Correlation Magnitude test)

Table 3-1 Bench Test Order of Results

accQmin electronics serial number, the electronics (cpu) firmware version, 
and a list of the component boards/devices with serial numbers.

Status of internal loop recorder.



WinADFM Software
Section 3  accQmin (Shallow Water Meter)

3-19

3.6 Program and Restart Select Start Sampling to begin flow monitoring immediately, or
at a predetermined time in the future. Delaying the start of flow
monitoring can be an advantage, if the meter is battery operated.
The system can be set up in-house, programmed using the
Program and Go button, and then transported to the field site at
a later time. Battery power is conserved until the date and time
to start sampling is met.

Check the box next to “Use advanced commands” to activate any
special commands entered in the Advanced Window's dialog box
(see section 3.4).

Figure 3-17 Start Sampling options

CAUTION
Advanced Commands should only be entered and used as
directed by Teledyne Isco.

3.6.1 Program and Go To load the application and operating parameters configured in
the station file into the accQmin and start the program, click
Program and Go.

After a few seconds of operation, a real-time screen appears, indi-
cating the accQmin has been programmed and started.

To exit the program, click Exit, and the screen will return to the
Operate screen. In the Operate screen, click Exit, then dis-
connect the communication cable. Close the station file and exit
WinADFM.

As long as the real-time screen is active, each time the accQmin
takes a reading based on its programmed sampling interval, the
real-time screen will be updated with the latest flow reading.

In addition to the real-time screen being continually updated, a
data file with the readings is sent to the computer. This file con-
tains data recorded during the time the real-time display screen
is active.

This file is automatically named rt, followed by the two-digit
year, month, and day, with an incrementing extension. The
extensions begin at .001. If Program and Go mode is used more
than once in the same day, the second rt data file will have the
extension .002, the third, .003, and so on. Data collected in Real
Time mode will also be stored in the accQmin's internal recorder
if the internal recorder is enabled.

The real-time display shows flow information in tabular format
including Depth, Ultrasonic Depth, Secondary Depth, Qmain
(actual computed flow), Qmann (computed Manning flow – if
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available), QmodAV computed flow, Average Velocity, and Raw
Velocity. A hydrograph and the raw data velocity signal graphs
are also shown (Figure 3-18).

Click Exit to return to the Connect screen.

Figure 3-18 Program and go real-time data screen

Graphs The top graph builds a hydrograph as real-time data is received.

Velocity Beam Graphs The four graphs below the hydrograph show the raw velocity
data. For specific information on the velocity beam graphs, refer
to Section 3.6.3, Quick Data Mode.

Depth Main depth used in flow calculation. Depth information from the
primary ultrasonic depth sensor is compared to depth infor-
mation from secondary depth sensor (if used). Best fit is deter-
mined and used for main depth.

Average Velocity Velocity divided by cross-sectional area

Raw Velocity Average of individual point velocities from the four velocity
beams

Qmain Calculated flow

Qmann Three inches of depth is required for velocity profiling. Below
that depth, flow is calculated using a Manning equation. A
hydraulic coefficient is calculated based on flow, and the last ten
velocity readings stored. Velocity is not displayed.
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QShape and QmodAV are not used with the accQmin.

Note
The same display appears for the three modes: Program and
Go, Quick Data, and Listen Real-Time. However, each mode
performs a different function. See Section 3.6.5 for an explana-
tion of these differences.

3.6.2 Adjust Offsets The Adjust Offsets feature is used in the field to check or adjust
the depth calibration of the ultrasonic depth transducer and/or
the secondary depth sensor.

Figure 3-19 Adjust Offsets window

When the screen opens, it will automatically update the ultra-
sonic and secondary depth readings. Enter the manually mea-
sured Depth. Click Calculate, and the new sensor offset will be
calculated. Click Set to change the existing sensor offset to the
new offset and program it into the accQmin. The new offset is
also saved in the station file.

Note
When clicking the Set button, watch the window box below the
Set button. If the window is not able to reprogram the new off-
set into the accQmin because the accQmin is doing other cal-
culations, the window will indicate a failure. Clicking on the Set
button a second time usually reprograms the accQmin, and it
will be indicated in the window. When finished, click Exit.
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3.6.3 Quick Data Mode The Quick Data feature is recommended for field evaluation and
diagnostics.

Quick Data is used in the field to view real-time data. Quick
Data displays a graphical and tabular screen in real time with a
data update approximately every 20 seconds. The Quick Data
real-time display is identical to the Program and Go display,
except for the update time.

Note
Upon exiting this screen, restart the meter using either the Pro-
gram & Go or Restart button.

Quick Data creates a data file of the readings and stores it in the
computer. This file will contain data recorded during the time the
real-time display screen is active, and contains the velocity beam
raw data used for diagnostics. This file is automatically named
qd, followed by the year, month, and day with numerical
extension. To view the Quick Data file and for analytical data,
refer to the WinADFM Quick Data Evaluation Section.

Note
The same display appears for the three modes: Program and
Go, Quick Data, and Listen Real-Time. However, each mode
performs a different function. See Section 3.6.5 for an explana-
tion of these differences.

3.6.4 Listen Real-time Mode Listen Real-time can be used in the field to view real-time data.
The Listen Real-time display is the same as the Program and Go
real-time display and Quick Data display. The Listen Real-time
information is updated on the screen each time the meter takes a
reading. In other words, it updates at the programmed sample
interval.

During the Listen Real Time mode, the internal recorder, if acti-
vated, continues to store data. Upon exiting this mode, the
current deployment continues and a new deployment is not
started in the recorder.

Note
The same display appears for the three modes: Program and
Go, Quick Data, and Listen Real-Time. However, each mode
performs a different function. See Section 3.6.5 for an explana-
tion of these differences.

3.6.5 Defining the Three 
Modes

Although the three modes display the same graphical, tabular
screen, their functions differ.

Program and Go Programs or reprograms the accQmin based on the configuration
settings in the station file. Starts a new deployment and captures
data on the computer, and also stores the data on the meter's
internal recorder if the recorder is enabled.
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Listen Real-time Captures data on the computer as sent out by the meter. If the
internal recorder is on, data continues to be recorded to the
current deployment. Upon exiting this mode, the current
deployment continues, rather than a new one starting.

Quick Data This mode updates the display screen approximately every 20
seconds, and is used in the field to view the operation of the
accQmin on-site and verify proper operation of the system. A spe-
cially modified configuration is used to obtain more rapid
updates than would normally be available, including a reduced
number of pings.

3.6.6 Restart This button will restart the accQmin using the programmed
parameters currently stored in its memory.

3.6.7 Sleep Sends an "off" command to the accQmin that puts it in Sleep
mode. The accQmin will not wake up at the specified sample time
and take a reading. In Sleep mode, the accQmin will only wake
up and start operating when a wakeup command is sent via the
Connect button.

Note
If the accQmin is put to sleep, immediately disconnect the
serial connection to the computer to prevent and accidental
wake-up of the accQmin.

3.7 Downloading and 
Viewing Data

To download data from the recorder, open the Connect window
(see section 3.5). Connect to the accQmin and click Collect Data.
All available data on the loop recorder will automatically be
downloaded. A dialog box will appear showing the status of the
download (figure 3-20). After completing the download, you will
be prompted to erase the recorder (figure 3-21). Teledyne Isco
suggests that the recorder in an accQmin be erased after each
download to avoid creating download data files with overlapping
data.

Figure 3-20 Collect Data window
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Figure 3-21 Prompt to erase recorder

3.7.1 Erasing Data To clear the recorder, click Erase Data in the Connect screen.

3.8 Viewing Data Data collected from the accQmin during Quick Data or Real Time
mode, or data collected from the internal recorder, may be viewed
using the View Data menus.

Open the station file of the site you want to view data from. From
the Menu bar, select Display > Data.

The Data file selection screen will appear. This screen lists all of
the Quick Data (qt), Real Time (rt), and internal recorder deploy-
ments available for the selected site.

Figure 3-22 ADFM Data window

The ADFM Data window provides several options for viewing the
data. Highlight the data file you want to view and then click the
viewing option on the right side of the window.
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3.8.1 Hydrograph The hydrograph displays time series data, showing flow, velocity,
depth, and fluid temperature.

Figure 3-23 Hydrograph

A vertical dotted line on the graph represents a specific
Ensemble (Data Point). The specific ensemble information,
including the values, is shown in the table to the right of the
graph. Click a point in the graph to move the dotted line and
display the values for that specific ensemble.

The slide bar below the table allows you to move from one
ensemble to another. The boxes beneath the slide bar show the
ensemble number. The arrows are used for moving to the
beginning or end of the graph, or to move to the next or previous
ensemble.

The Data Range box shows the starting and ending date/time of
the first and last ensemble. The start/end date/time of the graph
can be changed by clicking the arrows, or by typing the value in
the box.
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To change the graph range, colors, and line thickness, right-click
on the graph. A submenu will appear. Select Properties from the
submenu.

A Playback feature is activated by clicking the Play button. This
will advance the dotted line one ensemble at a time. To speed up
or slow down the playback, change the msec/Ensemble time
value in the box to the right of the Play button.

3.8.2 Scatter Plot The scatter plot window has check boxes to view Velocity vs.
Depth, Flow vs. Depth, and HC (Hydraulic Coefficient) vs. Depth.
Radio Buttons are provided to select either Variable N or Fixed N
for HC calculations.

Figure 3-24 Scatter Plot

Hydraulic Coefficient is back-calculated from Q, depth, and
channel geometry, based on the Fixed or Variable N radio button.

Variable N assumes that the coefficient of friction used in the
Manning equation varies with depth of flow. Fixed N assumes
that the coefficient of friction used in the Manning equation is
constant and independent of depth of flow.
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3.8.3 Expert View Expert View includes graphical displays of the hydrograph and
raw data.

Figure 3-25 Expert View

Expert View also shows tabular values for Depth, Ultrasonic
Depth, Secondary Depth, Qmain, Qmann, QmodAV, Average
Velocity, Raw Velocity, as well as hydrograph and the velocity
signals.

Graphs The top graph is a hydrograph of Q, V, and D.

Velocity Beam Graphs The three graphs below the hydrograph show raw data infor-
mation.

Depth Main depth used in flow calculation. Depth information from the
primary ultrasonic depth sensor is compared to depth infor-
mation from secondary depth sensor (if used). Best fit is deter-
mined and used for main depth.

Average Velocity Velocity divided by cross-sectional area

Raw Velocity Average of individual point velocities from the three velocity
beams.

Qmain Calculated flow

Qmann Three inches of depth is required for velocity profiling. Below
that depth, flow is calculated using a Manning equation. A
hydraulic coefficient is calculated, stored, and updated during



WinADFM Software
Section 3  accQmin (Shallow Water Meter)

3-28

velocity profiling. This hydraulic coefficient is used with the
Manning equation to calculate flow. Raw Velocity may not be dis-
played.

Bit Codes BIT (Built in Test) codes indicate errors that occurred during the
course of an individual reading. Beginning with WinADFM
version 1.47, BIT codes are displayed in hexidecimal form. See
Appendix A BIT Codes for ADFM and accQmin for details.

3.8.4 Data Quality 
Parameters

Data in the Expert View screen is a good indicator of the quality
of the data. The Raw Data velocity beams in Expert View refer to
the raw Doppler-based velocity components measured by each
individual beam.

Amplitude The accQmin operates by emitting a sound pulse and then
receiving the echoes backscattered by material suspended in the
flow. Amplitude data is a measure of the signal strength of these
echoes. The amplitude normally decays from a high value near
the sensor (bottom of graph) to a lower value at the end of the
profile range (near the top of the graph). This is due to several
factors, including the natural spread of sound energy as it travels
farther away and loss due to absorption of sound energy by the
water and suspended material. A signal of 128 to 192 is con-
sidered normal.

Correlation Correlation is a measure of the quality of the processed velocity
information. An expected Correlation value is approximately 128
to 192 counts.

Vertical and Horizontal 
Velocities

Each of the three velocity beams is divided up into the three
velocity measuring “bins”.

Beam 1 (red) should be positive, as it faces upstream. Beams 2
(green) and 3 (blue) should be negative, as they face downstream.
If any velocity bins are missing from an ensemble, it indicates
that there was no velocity information available in that bin for
that ensemble.

The horizontal velocities should be relatively flat, with the
second bin, or middle point, slightly higher than the first and
third velocity bins.

3.8.5 Examples of Raw Data The following examples provide a guide for interpreting the data
in Expert View.

Note
The Flow Profiles screen and Data Reprocessing are not avail-
able in the accQmin.

3.8.6 Table To view the data in tabular form, select Table, then select the
desired data file from the list.

A data file can be saved in CSV or extended CSV format for use
in a spreadsheet. To save in CSV, highlight the data file, checking
the box for extended CSV if desired, and click Save as CSV. 
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Figure 3-26 Tabular data display

A data file saved in CSV format and then opened with a spread-
sheet program will show Date/Time, Depth, Velocity, and Flow. If
additional flow information is desired, such as water temper-
ature, click in the Save Extended CSV Data box before clicking
Save as CSV. The same data saved as extended CSV provides
more data information and is shown in Figure 3-27).

Note
Only Qmain is ever output as the final flow value as computed
by the accQmin. All other Q-related values are for diagnostic
purposes, and should be ignored by the user.
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Figure 3-27 Tabular data in Extended CSV format
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3.8.7 Composite View Composite view provides a composite hydrograph of multiple
data files. To select more than one file to view, highlight the first
file, hold down the Control key, and highlight the other file(s) to
view.

Figure 3-28 Composite View
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WinADFM Software

Appendix A  BIT Codes for ADFM and accQmin

A.1 ADFM BIT Codes The ADFM uses a bit-mapped value for the BIT (Built In Test)
code. Each of the 16 bits (4 hex digits) signifies a different error.
The ADFM outputs a BIT code with each ensemble that reflects
all of the errors that occurred during that ensemble. Common
ADFM errors and their corresponding BIT codes are shown
below in table A-1:

If multiple errors occur, the resulting BIT code will be the alge-
braic sum of the individual codes. For instance, a BIT code of
0820 hex corresponds to a transducer communications failure
and a secondary level sensor failure.

A.2 accQmin BIT Codes The accQmin outputs error codes in a manner substantially dif-
ferent from the ADFM. The accQmin uses an 8-bit hex value for
each error, and maintains a queue of recent errors. The output
for each ensemble consists of the number errors in the queue,
and the hex value for the first error code in the queue. As new
errors occur, the queue is first searched to determine if that error
code is already in the queue. If it is, the new occurrence of that
error is ignored. If it is not already in the queue, the error code is
added to the end of the queue and the error code counter is incre-
mented. As error codes from the queue are output, they are
removed from the queue and the counter is decremented. For
example, if the accQmin error code is 0291, there are two error
codes in the queue, with the first (oldest) error code in the queue
being 91 – Interlock Open.

Table A-1 Common ADFM Errors and BIT Codes

Bit Error Decimal Hex

6 Secondary Level Sensor Failure 32 0020

7 Demod Timeout 64 0040

8 Demod LCA failure 128 0080

9 Auto Restart Occurred 256 0100

10 Demod FIFO failure 512 0200

11 Power/Timing failure 1024 0400

12 Transducer (Sensor) Communications Failure 2048 0800

13 Recorder Full 4096 1000

14 Recorder Failure 8192 2000
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Only one error code is output per ensemble, and it will be the
oldest one in the queue. Therefore, although the error reported
for a particular ensemble may have occurred during that
ensemble, but not necessarily. Also, multiple errors may have
occurred during that ensemble. If you are getting bad data, you
will need to look through several ensembles to see the full list of
error codes being generated. When the errors begin to repeat,
you can be fairly certain you’ve seen a comprehensive list.

Table A-2 contains a list of accQmin error codes.

Table A-2 accQmin Error Codes

Code (hex) Error Description

22 Temperature Sensor Fail Indicates that the temperature sensor is not available or is not configured 
properly. The transducer must be connected to the electronics when the 
BREAK is sent, or the temperature sensor will be flagged as unavailable 
for the duration of the deployment.

23 Pressure Sensor Fail Indicates that the primary depth sensor, if it is the pressure sensor, is not 
available. If the Expander board returns a pressure sensor failure mes-
sage, this code is set.

30 UART Stuck Ensemble data is ready for output and the UART interrupt can’t be 
cleared.

31 UART Tx timeout A new ensemble is ready to be output and the previous ensemble is still 
in queue after an excessive length of time.

32 UART IRQ Stuck Data has been in the interrupt handler loop for more than 30000 consec-
utive loops.

33 UART Buffer Stuck The output buffer is full, and a character has waited more than 100 msec 
to be added to that buffer.

35 UART No Clear The system is waiting to go to sleep, and the UART interrupt doesn’t 
clear after 20 msec.

37 UART Sleep Timeout The system does not have enough time to sleep due to data output.

40 VB No Detect The Vertical Beam is unable to detect the surface in the DWADFM or 
VADCP modes. 

50 RTC Battery Low The Real Time Clock reports a low battery condition.

51 RTC Time Not Set The time was reset due to power interruption and the user has not set the 
time with the TS command.

60 Recorder Pointers Lost RAM based pointers to the next recorder write location are lost due to 
power interruption or a firmware download.

61 Recorder Erase Error The system is unable to erase the Loop/Slate recorder Flash memory.

62 Recorder Data Read 
Time-Out

While attempting to read a page of data from the Flash memory, a time-
out occurred.

63 Recorder Data Write 
Time-Out

While attempting to write a page of data to the Flash memory, a timeout 
occurred.

64 Recorder Page Erase 
Time-Out

While attempting to erase a page of Flash memory, a timeout occurred.

65 Recorder Erase Status 
Error

The Flash memory control register returned an error indication after an 
erase took place.

66 Recorder Slate Full The recorder is in the Slate mode and the recorder is full.
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71 Beam 1 Bad While processing Beam 1 velocities, one or more bins were flagged as 
bad.

72 Beam 2 Bad While processing Beam 2 velocities, one or more bins were flagged as 
bad.

73 Beam 3 Bad While processing Beam 3, velocities one or more bins were flagged bad.

76 Vertical Beam Failure In SW mode, the vertical beam percent good was less than 50%.

77 Vertical Beam Marginal In the SW mode the vertical beam percent good was less than 70%.

78 Flow Shape Failure A comparison between the actual measured velocities and the HRW 
model had a value greater than 0.1 (0 = perfect fit).

79 Flow Shape Marginal A comparison between the actual measured velocities and the HRW 
model had a value greater than 0.01 (0.0 = perfect fit)

7A Unable to Calculate 
Discharge (Q)

The system could not calculate Q due to too few velocity bins (need at 
least 6 good ones) or a depth estimate was unavailable.

7B Temperature Sensor 
Failure 

Over at least the last four sample periods, the temperature sensor did not 
return a valid temperature.

90 I/O Expander Board 
Failure

The system was unable to establish communication with I/O Expander 
board via the SPI bus.

91 Interlock Open The I/O Expander board detected a failure in the external connector 
interlock pins.

Table A-2 accQmin Error Codes (Continued)

Code (hex) Error Description
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